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PREFACE 

This book serves as open educational material for both undergraduate and postgraduate degree 

programs, offering a detailed, step-by-step guide to Medium-Sized City’s Urban service Profiling 

Designed to bridge the gap between theoretical knowledge and practical application, this guide is 

meticulously crafted to meet the needs of students, educators, and practitioners alike. 

Within the book, readers will find comprehensive instructions on using Google API data, employing 

GIS software to analyze spatial information, and interpreting this data to understand the distribution 

of city service points of interest (POIs) to pinpoint community-level shortages. It then explores the 

relationship between facilities and population within specific distance-based isochrones (considering 

walking distance). The book not only enhances learning in academic settings but also equips 

industry professionals with the skills necessary to conduct advanced spatial analysis and contribute 

meaningful insights in their fields. 

Whether you are a student aiming to study the proximity & accessibility of urban services in medium-

sized cities, a teacher looking for robust educational tools, or a practitioner in need of refining your 

technical expertise, this book offers invaluable guidance and support. It ensures that users at all 

levels gain proficiency in leveraging modern applications to explore urban service profiles of cities 

and study them effectively. 
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1. INTRODUCTION  

This training book offers a comprehensive guide to analyzing whether Sri Lankan cities qualify as 15-

minute cities, using software ARC GIS can substitute with open-source software QGIS and the Open-

Source Data usage Google (OSM). The book provides instructions on how to edit source code used for 

data extraction and utilize field mapping and graphical interpretations of the results. 

The analysis starts by reviewing the distribution of city service points of interest (POIs) to pinpoint 

community-level shortages. It then explores the relationship between facilities and population within 

specific distance-based isochrones (considering walking distance). This involves examining the 

distribution of facilities relative to the population to assess whether the available facilities suffice for the 

population's daily needs. Measurements of proximity and accessibility are conducted using graph 

topology, forming the basis for further analysis. An analytical index, unique to each city, is developed 

to reflect its essential geographical characteristics. This index aids in categorizing cities and identifying 

potential enhancements to strengthen their regional roles. The book is designed to be both expandable 

and replicable, allowing for the inclusion of more indicators to refine each city's index. 

The book is structured into three chapters: 

• Chapter 2: Introduction to the book 

• Chapter 3: Describes the four-step methodology used in the assessment, including examining 

city-level services with data collection, analyzing the interplay between services and population 

to identify underserved areas, calculating service availability within each buffer zone around 

facilities by determining the ratio of the number of facilities to the population and the distance 

from POI to the nearest facility POIs and evaluating city attractiveness through available 

categorized services using a gravity indicator, and, taking into account the proportions for each 

category of facility. 

• Chapter 4: Annextures 
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Graphical representation of the facility to population Dispersion in a medium-sized city (Final 

Result) 

 

 

 

 

 

 

 

 

 

 

 

 

The Network Analyst tool examined service Accessibility of the city, for city residents. And explores the 

relationship between facilities to population dispersion within specific distance-based isochrones. Which 

Evaluates Medium-Sized Cities' Progress Towards Achieving the 15-Minute City Ideal in Terms of 

Accessible Urban Services. 

 

 

 

 

 

 

Figure 1:The proximity of residents to various facilities in Kurunegala city (starting from categorized services) 
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2. OVERVIEW 

The overall procedure presented here provides a clear overview of the methodology and the sequential 

steps involved in the evaluation process. 

 

3. Required Tools / Software  

REQUIREMENT 

APPLICATION • Softwares 

 

• ARC MAP / QGIS PRIZREN 3.34 

(Installed ORS Plugin) 

• Google Colab / Pycharm 

DATA COLLECTION • Web pages 
• Google Cloud platform 

 

 

 

Figure 2: Entire process in a flow chart 
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4. DATA COLLECTION AND METHODOLOGY 

 

To conduct the analysis, the overall methodological framework follows four basic processes. 

I. First, the categorization of the services into eight categories; Administrative services, 

Commercial services, Cultural services, educational services, Health care services, 

Recreational services, Shopping services, and public transport services (Table 01), applicable 

to Sri Lanka referring to applicability and literature.  

II. Second, POI data extraction using Google API and Google My Maps. The services available 

within a 2km radius of the city's major point of insertion have been selected.  

III. The third step is to take the measurements of distances (isochrones) and time by considering 

speed by employing a network analyst tool.  

IV. Fourth, calculated the service availability of each buffer zone around the facilities by 

determining the ratio of the number of facilities to the population, and distance from POI to the 

nearest facility POIs considering proportions for each category of facility. 

V. Calculation of the city’s service attractiveness index. 
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4.1 Data categorization and collection 

4.1.1 Data Categorization 

The data categorization model for this book was established after reviewing various studies on data 

categorization in cities worldwide that relate to 15-minute cites studies (Literature review). The 

categories identified can be adjusted based on the unique characteristics of each city or according to 

local priorities and preferences. The selected categories for this book are as follows: 

Attribute  Facility  

Educational Type 1A, 1B: Schools with GCE Advanced Level (A-Level) classes 

Type 1C: Schools with GCE Advanced Level (A-Level) art and 
commerce classes.  

Other schools 

Tuition classes  

Nursery 

Health care Government hospitals 

Private Hospitals   

Dispensaries  
Pharmacies  

Cultural  Religious places  

Library   

Administrative Government institutions  
Administrative offices   

Post offices.  

Commercial Banks  

Financial institutions  

Restaurants   

Shopping Supermarkets  

Clothing centers  

Public markets  

Public transport stops Railway stations   

Bus stands & Nodal Bus stops.  

Recreation & 
Entertainment 

Public parks & Playgrounds  

Indoor sports complexes & fitness centers  

Cinema halls  
 

Table 1:POI Data Categorization and Sources. 

 

Note: If there are preprocessed categorizations available within your local context, they can be used as 

substitutes for the current categorization. 

 



 

6 | P a g e  
 

4.1.2 Data Collection 

The initial step of the process is to collect the data. This data collection process entailed compiling 

information on diverse facilities within 2km buffers from the city center and organizing them into eight 

distinct categories. These included Administrative, Commercial, Cultural, Educational, Healthcare, 

Recreational, Shopping, and Public Transport services. 

To ascertain the number of facilities in each category within a 2km radius, Point of Interest (POI) data 

and information from Google My Maps were employed. POI data encompasses geospatial coordinates 

and supplementary details such as names, categories, Coordinates (addresses), and contact 

information. For this study, POI data were sourced from the Google Maps Places API (accessed in 

December 2023). Since it's an electronic platform with different and unique features, we must create a 

unique Python code to extract the data from the website. 

Step 01: 

Creation of Google API key  

1. Access Google Cloud Console: https://console.cloud.google.com/ 

• Navigate to Google Cloud Console 

• Log in using your Google account 

• Select the option Try “Google Cloud Free” select “Country” and Click “AGREE & CONTINUE”. 

https://console.cloud.google.com/
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• Enter the legit data for the following questions, And click the Button “Create” 

• Click the “Payment Method tab. Add credit or debit card details. 
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• The window will appear like this,  

• Enter the legit data for the following questions, And click the Button “Done” 
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• You will open into window like this, and click the icon at the upper left corner, 

 

• From this drop down go to “Google Maps Platform” and Select “Keys and Credentials” where 

you will able to obtain the generated personal “API key”. 
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• Here copy the API Key on your “Clipboard”. 

 

2. Document and Save the Key: 

      Note down the key securely in a notepad.  

3. Enable APIs: 

• Go to “API & Services” in left upper corner drop-down, 

• Click on “Enable APIs and Services” and search for the necessary APIs (e.g., Google Maps) to 

enable. 
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4. In here, Enable Places API, 

 

 

5. Check the places API data compatible with your categorization, 

Go through this link: https://download.geofabrik.de/osm-data-in-gis-formats-free.pdf 

• The next step is to extract the POI data, for that, you need to run a code in Python, before that 

clarify the available data format and classes you are going to request from the “Google API”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Most Importantly, Billing information (https://developers.google.com/maps/billing-and-

pricing/billing) needs to be checked in before any request from Places API using the following Python 

code.  

 

 

https://download.geofabrik.de/osm-data-in-gis-formats-free.pdf
https://developers.google.com/maps/billing-and-pricing/billing
https://developers.google.com/maps/billing-and-pricing/billing
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Step 02: 

• Open the below code (Figure 01) in a Python notebook (Google Colab preferred), 

https://colab.google/ 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Then inside “Google Colab” there is an option to go for a “New notebook” Click that option,  

 

 

 

 

 

 

 

 

 

 

 

 

 

• It will direct you to the following interface, 

 

https://colab.google/
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• Now you have to set the Environments of the colab notebook, write the below note in the notebook, 

and run using the “Play icon” button.  

•  

 

 

 

 

 

 

• Output results will look alike as follows, 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Take a new phase using the “+code” icon in the upper tab write the following note and run the code 

as same in the above step. 
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• Take a new phase using the “+code” icon and enter the following code, 

 

Figure 3:Python code & API key prepared to obtain POI data from Google API 
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Before running the code add the saved Google API key (Copied earlier and saved in a notepad), center 

point (Latitude and Longitude) of your center point, radius, and service type (according to your 

categorizations).  

Note: Things should be subtitled according to the work indicated in red color boxes.  

Valid service types are listed in the Google API documentation (https://download.geofabrik.de/osm-

data-in-gis-formats-free.pdf).  

PS: Selected Location for this analysis: “7.874126220945256, 80.65109203759063”, 

Selected API key: Personal API key 

Selected Radius: 2000 meters 

Selected Type: Restaurant 

• Now you can download the XLSX file following these steps, 

 

 

 

 

 

 

 

 

 

 

 

• The downloaded data file will look like the following, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Likewise, needed categories could be downloaded by running the code in Google Colab.  

 

Note: Make sure to check the billing details (Number of Requests) 

https://download.geofabrik.de/osm-data-in-gis-formats-free.pdf
https://download.geofabrik.de/osm-data-in-gis-formats-free.pdf
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• Data cleaning (Remove the unnecessary data in CSV and keep data needed for your analysis)  

From this detailed Excel, for this study purpose “Location” and “Name”, other should be removed. 

 

Step 03: 

• Convert the XLSX file into to CSV file,  

Open XSLX file > File >Save as > Browse to the location > Select the Save Type as CSV 

 

 

 

 

 

 

 

 

Insertion of those (CSV files) into the Arc GIS/ QGIS, using the below step we can spatially interpret 

the Point data into the project. For this example, Bank data of city of Kurunegala has been used.  

(1) Open ARC map > (2) Browse the CSV file from “Catalog” > (3) Drag and drop the CSV file into 

the Project.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4: Insert CSV files to ARC Map 

(2) 

(3) 

(1) 
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• Right-click on the “Banks” Layer displayed in “Table of Contents”. This popup menu will appear and 

set X Field as “longitude”, and Y Field as “latitude”. Then click the “Edit” button to set the coordinate 

system.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.Geographic 

Coordinate systems 

> World > WGS 

1984  

2. Click “OK” 
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• Spatially, POIs belonging to the CSV will be displayed on the project as follows: 

 

• According to the service categorization (Table 01), Under the “Commercial” categorization there 

are 3 subcategories; Banks, Financial institutions, and Restaurants.  

 Addition of those layers as CSV files to the project and convert them into point layers by following 

the above steps. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• To set those layers as one layer (Commercial Layer) Merge option in the “Geoprocessing” toolbox 

should be used. 

Go to Geoprocessing > Click drop-down > Select “Merge” You will open up to the following popup 

menu, 
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• Now you can obtain commercial category as one layer, likewise, we can formulate other categories 

as well (Reference with Table 01). 

 

 

 

 

 

 

 

 

 

 

 

 

Note: (Location selected to extract API data; major population insertion point to each city has been 

selected). For example – the coordinates of the bus stand as the center point.  

 

 

4.2 Preparation of the Data Layers 

4.2.1 Insertion of the population data into the project 

Population data for cities were sourced from the 2012 Statistical Yearbook published by the Census 

and Statistics Department of Sri Lanka. Enable the population layer into Population density. This can 

be obtained easily if the population density data is already processed.  

Select “Input Datasets” as 

given, and direct for 

“Output” location > Click 

“OK” 
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Figure 5: Displaying Population Density. 

Otherwise, create a new field in the attribute table and use the calculated geometry in the attribute table. 

Use the equation (Population / Area) = Population Density. 

 

Figure 6:Calculate Population Density 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Right Click on layer > 

Layer properties > Drop 

down the Field > Select 

the population density 

field. 

2. Right Click on layer 

> Open attribute table 

> Add a new field > 

Right click on the new 

column > Field 

calculator > Insert the 

equation > Ok. 

3. Right Click on layer 

> Open Layer 

properties > Go to 

symbology > Select the 

Quantities option and 

apply density layer in 

the value field and 

classify according to 

your preference > OK. 

Figure 7:Classify Population Data 
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In here the classification done according to Natural breaks where class quantity is selected as 5. This 

could be customized according to the preference and the nature of the data inserted. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

This Figure shows one of the 

sample maps for population 

density distribution in the 

nearest Grama Niladhari 

Divisions around the city 

center (Kurunegala). In this 

case the population data 

classified in to 10 classes. 

Figure 6:Mapping population Density. 
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4.2.2 Insertion of the Road data into the project 

Note: From this point onward in need of easy demonstration Kurunegala city will be in focus. 

 

Step 01: 

• To run the Network analyst tool, a digitized road data layer (Split at vertices) must be prepared. The 

following steps could be incorporated into the process. This can be done either bookly or using the 

tool “Feature to Line” from the Arc Toolbox. 

• Before deploying “Feature to Line”, Go to the “Geoprocessing” tool and Select the “Dissolve” option 

from the drop-down menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The dissolved layer will automatically appear on the project, and then do as follows: 

Select Road Layer as the “Input 

Feature” & Direct for a “Output” 

location. And Click “OK” 
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Then we can obtain a road layer split at vertices. 

 4.3 Summary  

The ARC GIS software elaborated geo-referenced data. Following the city's geo-localization, the project 

involved uploading all geo-referenced files related to services from OpenStreetMap (API) and census 

data (population) from the Census and Statistic Department of Sri Lanka into the ARC GIS project. A 

maximum observation distance of 2km from the city center was established. Subsequently, the 

preparation of the road layer entailed digitizing individual road segments and setting up the Network 

Analyst tool. 

 

 

 

 

 

 

 

Go to Arc toolbox > Data 

Management Tools > 

Features and then select 

“Feature to Line” option.  

Select input feature as the 

Road Layer and direct to 

Output Feature Class.  

 

Figure 7:Split Road layer.  
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5. Application Section - Medium-Sized City’s Service Profiling 

5.1 Deploying Network Analyst Tool 

The application section discusses the deployment of two tools in ArcGIS and QGIS software: the 

Network Analyst tool and the ORS plugin, respectively. Both can be done through QGIS software as 

there are constraints in loading the data here onward Network Analyst tool will be guided by Arc GIs 

and steps from QGIS will be mentioned parallelly. Before running the NA tool, you must enable the 

Extension. 

• Enabling Network Analyst tool, 

• Check the box, 

Go to the “Customize” option in the upper of UI and go to “Extensions”. Check 

whether the “Network Analyst” option is enabled. If not, enable it. 
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5.1.1 Creation of Impedance in the Attribute Table 

Then you must create the impedance in the Attribute table of the split road layer 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 – Add field. Right 

click on the given icon 

and select add field. 

2 – Name the field & select the “Type.” Note: 

Spellings for “Meters” should be exactly the 

3 – Right click on the added column (Meters) & 

select “Calculate Geometry”. 
4 – Select the “Length” from the drop down 

menue. Make sure to select standard units. 

 

 

The attributes of the road layer, after deploying 

“Feature to Line” will appear like this. 

(Right click on “Feature to Line” layer > Click “Open 

Attribute Table”) 
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Note:  

Set the speed according to requirement. This study focus on walkability I use 1.34 ms-1 as the 

average walking speed of a person. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5 – Prepared impedance 

8 – Outlook of the attribute 

table after calculations  

6 – Add a New field, Name it as “Speed”, 

Right click on column and go to “Field 

Calculator” Enter “1.34” Click “OK”.  

7 – Use the Formulea “Distance/Speed = Time” 

Since Network Analyst tool requests Time in 

“Minutes” formulae should appear as 

“([Meters]/[Speed])/60” 
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5.1.2 Creation of New Network Data Set 

 

 

 

 

 

 

 

Now this will guide to creation of a New Network Dataset, 

 

 

 

 

 

 

 

 

 

Insertion of the point layer 

going to analyze into the 

project and then in the 

catalog right click on the 

split road layer > go to New 

Network dataset. 

1 - You will open to this window go 

ahead with “Next” button. 

2 - You will open to this window 

Click “Yes” and go ahead with 

“Next” button. 

4 - You will open to this window. 

Click your preference and go 

ahead with “Next” button. 

3 - You will open to this window go 

ahead with “Next” button. 

Figure 8:Steps to create Network data set. 
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Go to Nework analyst tool in the tab and now the tool is enabled for the work. In the drop-down menu 

select the “New Service Area” option.  

  

 

5 – Check these attributes are 

displaying here. 

6 – Select Time attribute as 

“Minutes” & Distance attribute as 

“Meters”. 

7 – Select “No” and click “Next”. 
8 – Click “Finish”.  

9 – Click “Yes” 

 10 – output  
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5.1.3 Creation of the service Area and Set properties 

 

 

  

 

 

 

 

 

 

 

 

 

Activating the “Multiple Facility Polygon Generation” feature with a buffer distance set at 200m, thereby 

plotting a 2km walking isochrone to underscore the services within the walkable radius from the selected 

facilities.  

 

 

 

 

 

 

 

 

 

 

11 – Click on this drop down & 

Select “New Service Area.” 

12 – Select “Network Analyst 

Window” in the tool set. 

14 – Select the point layer here 

(Administrative POI data Layer) 

15 – Go to “Properties” 

of “Service Area” 

16 – Go to “Analysis 

Settings” Fix Impedance as 

“Meters” and give the 

“Default Breaks”; Selected 

breaks for this study are 

200,400,600,800,1000,120

0,1400,1600,1800,2000 in 

meters. 

13 – Right click on “Facilities” and 

select “Load Locations” option. 
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5.1.4 Incorporating population data.  

Incorporating Population Data into the Network Analyst, add the population data containing the DSD 

file (From the Department database) into the project select the area where the network is spread, and 

export the collection of DSDs as a separate file. 

• Go to Catalog > Browse to Population Layer which is pre-processed > Drag and Drop on Project.  

 

  

17. In “Polygon Generation” tab, put “200m” as 

the “Trim Polygons” extent, while selecting 

“Merge by break value” Multiple Facilities Option 

& Overlap Type as “Rings.”  

18. Use “Solve” option in “Properties”. Service 

Area > Solve. 

 

20. Click “Select Feature” icon and select the 

DSDs within the network service area.  

21. Export them as a separate layer. Right 

click on layer > Data > Export 

19. Service Buffers output is here. Follow same 

process for each category (11th step to 18th 

Step). This is to identify unique service areas 

belong to each category.  

 

Service Area of Administrative 

service, according to isochrones. 
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5.1.5 Pixel Value concern to calculate population density of separate zones (Isochrones), 

 

 

 

 

  

 

 

 

 

23. Easy of calculation population data will be 

converted into raster format. Conversion 

tools > To Raster > Polygon to Raster  

 

22. Since population data available in DSD wise, 

this step conducted. 

24. Select the Newly exported population layer 

as the “Input Feature”. Set population density as 

“Value Field.” Assign “Cell size” according to the 

nature of the data.  

25. Population layer as a Raster layer 

 

26. Enable “Select Feature” option and select 

the separate isochrones and export them 

accordingly. Above example shows the 200m 

isochrone selection. 

27. Right click on “Polygon” layer and go to 

“Data” and export it as a separate Layer.  
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Graphical representation of population density data with distant buffers, 

Note: Repeat the same steps for all the 10 isochrones.  

 

  

  

 

 

 

 

 

 

 

28. Import a copy of export layer in here. 

29. Arc Toolbox > Data Management Tools > 

Raster > Raster Processing.  

 

30. Insert converted population raster layer as 

the “Input Raster”, And select the “output Extent” 

from exported Isochrones (200m) and make 

sure to tick the given box (Clipping Geometry” 

 

31. This shows the output raster after clipping 

200m isochrone with population data. And 

attribute table as well.  

 

“Count” attribute 

denotes the 

number of pixels 

belong to 200m 

radius;" “Value” 

field denote 

density of the 

DSD as whole. 

Population can 

obtain through the 

following 

equation, 

 

32. Add new field. Then right click on new column > select “Field Calculator” 

from the drop-down menu. Enter the equation [Value* Count* 0.030*0.030] 

Note: Selected pixel size is 30 meters. 
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• Bookly enter each data into a spreadsheet and calculate population density using 

Formulea; ([Population]/[Area] = Population Density). 

•  

 

 

 

 

 

 

 

 

 

 

 

33. Right click on population column and note the sum of the population live in that zone (200m). 

34. Add all data in spreadsheet. Belong to each category.  

Distance  

Population Density 

Figure 9: Insert Insertion of data into Excel. 
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5.2 Graphical representation of the details (Population Density vs. distance) of 

Service Categories. 

Plot the details in the corresponding fields accordingly. Using the data in Figure 10.  

 

 

 

 

 

 

 

 

 

  

 

 

Graphical results are given in the above graph. How the dispersion of facility to population has been 

identified in the city of Kurunegala. This figure highlights the dense clustering of various facilities within 

the city, with a maximum observational distance of 2000 meters along the x-axis.  

 

 

 

 

 

 

 

Figure 10:The proximity of residents to various facilities in Kurunegala city (starting from categorized services) 
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5.3 Distance from POI to the nearest facility POIs considering proportions. 

Using the Network Analyst mechanism (output data), the proximity of services to each other can be 

analyzed to identify the availability of linked services (from one service to other services), considering 

the number of services within specific isochrones. This analysis can be conducted. 

 

 

Insert all the POIs belonging to all categories into the project. Let’s take the pattern of deviation of 

commercial Points from administrative service buffers, 

 

 

 

 

 

 

 

 

1. Go to Geoprocessing 

tool > select “Clip” in 

the drop-down menu.  
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Note that a spreadsheet helps to draw a chart compared to the other services, The Above practice 

should repeat to each category of services, for all 10 isochrones separately.  

The below spreadsheet shows the note of data required to check the linked service (7 

categories) to the Administrative Service.  

• Insert the extracted data into to spreadsheet bookly, considering the available number of services 

within specific isochrones. The density Column shows a proportion of data belonging to each 

isochrone as a proportion of the same category.  

 

 

 

2. Select “Commercial 

layer” as the “Input 

Feature and 200m buffer 

(vector layer) as the “Clip 

Feature”. Output will be 

the commercial points 

which are located within 

the 200m buffer zone 

belong to Administrative 

Services. 

3. Number of POIs can 

count using the attribute 

table of the created 

layer. (Clipping 

Commercial services 

within the 200m buffer 

zone of Administrative 

Services) 
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Figure 12: The Proximity of people to various facilities in 
Kurunegala city (Starting from Administrative points 

 

 

 

 

 

 

 

 

 

 

Above is the summarized data (Proportions) which is used to plot the graph regarding linked services.  

 

 

 

 

 

 

 

Validating the attractiveness of services from the city center: Adapting and applying the gravity-based 

model. 

4. Select the data and go to 

“Insert” tab in excel > Select 

“Insert Line or Area Chart”. 

Note: In this graph, the Y axis 

indicates the proportion of services 

available within the considering 

zone while the X axis indicates the 

selected isochrones. 

Figure 11:Entering proportional data into excel for processing. 
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5.4 Deploying ORS Tool 

The ORS (Open Route Service) tool, a plugin in QGIS, integrates the functionalities of the Open Route 

Service API within the QGIS environment where a separate API key is generated for the Routing 

service. This versatile online service delivers routing solutions based on OpenStreetMap (OSM) data, 

enabling QGIS users to access a wide array of services from Open Route Service. These services 

encompass Routing, Isochrones, Matrix, Geocoding, and Reverse Geocoding. 

The Matrix tool within ORS generates a matrix of travel times or distances among multiple points, 

serving as a key asset for optimizing logistics, analyzing networks, and conducting in-depth accessibility 

studies. Measuring distances from various points to the city center plays a pivotal role in the creation of 

a gravity index. 

Gravity-based models effectively evaluate a specific zone's accessibility with surrounding zones. 

Borghetti et al. (2021) adapted the gravity index to measure human attraction. In this study using that 

index during the validation phase. 

To run the ORS tool first, we need to prepare a Routing API Key, 

1. Click “open route” service in Google and go to https://openrouteservice.org/dev/#/login this link 

and create an account. 

2. You will be directed to this window, 

 

Figure 13:Creating an account in open route service. 

3. Submit it and log in for free use. 

4. Request for a token here by entering “Token Type” & “Token Name.” And then click “Create a 

Token.” 

https://openrouteservice.org/dev/#/login
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5. It will provide an API key in the given location, which you need to copy for the clipboard.  

 

 

 

 

 

 

 

 

 

6. Open QGIS software and check whether the ORS plugin is available or not, 

 

 

 

 

 

 

 

7. Then you will be directed into the following window, 

 

 

API Key 
API Key 

API Key 1. Go to Plugins tab and 

click “Manage and 

Install Plugins.” 

 

 

2. Go to Plugins tab and 
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8. Insertion of the POI data into the project. 

 

 

 

 

 

2. Type ORS in the search 

bar and check is it already 

installed, otherwise install it 

clicking “Install”. 

 

 

3. Browse to shape file 

from the “Browser” tab. 

Then add the POI layers 

from the saved location. 
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9. Go to the ORS tool. 

 

10. Window of the ORS tool 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Click “Web” icon on 

tab of UI and Select 

“ORS Tools” from the 

drop-down menu. 

API Key 

API Key 

API Key 

5. In the “ORS Tools” Click the icon of 

“Provider Settings”. In here you can enter 

the API key which you copied from the 

“open routing service” > Click “Add”. 

Enter API Key here. 

 

Enter API Key here. 
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11. Fix the settings. 

 

 

 

 

 

 

 

 

 

 

12. Since we are going to measure the city attractiveness index. This study uses insertion points 

as the Bus station of Kurunegala as the center of services, it varies with the context and the 

situation. Therefore add the center point of the city to the project as a shapefile. This enables 

us to calculate the distance from every service administrative point to the bus stand of 

Kurunegala.  

 

 

 

  

 

 

 

 

 

 

 

6. Click “Advanced Directions” 

and select above from 

dropdown menus. 7. Click “Batch Jobs” and click 

“Matrix” icon.  

API Key API Key 

API Key 

API Key 

API Key 
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13. After clicking the Matrix button in the “ORS Tool” window, this window will appear, where you 

need to select the Mode of travel, Input start point layer, and Input Endpoint layer as well. 

 

 

 

 

 

 

 

 

 

 

14. Running process.  

 

 

 

 

 

API Key 

API Key 

API Key 

API Key 

8. Enabling option “Open output file after running 

Algorithm”, Run the tool.  
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15. Repeat this for other services as well, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. This kind of Matrix layer will appear, and you 

need export as a XLSX file. 

 

10. Direct place to 

save and export the 

layer. 
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16. Generalized Cost in Kilometers from the Point of Consideration to the i th Service Point 

calculated for each service category in the selected city Kurunegala, The sheet can be 

organized as follows,  

 

 

 

 

 

 

 

 

 

17. Gravity-based models effectively evaluate a specific zone's accessibility with surrounding 

zones. Borghetti et al. (2021) adapted the gravity index to measure human attraction. 

5.5 Defining Equation & the Calculations 

 

𝑆𝐶𝑂𝑅𝐸𝑐𝑖𝑡𝑦 = ∑ 𝜔𝑘

0

𝑘

∑(𝑛𝑘)𝛼 ∗ exp (−𝛽 ∗ GC𝑖) 

0

𝑖

 

 

▪ n∘ service ik = number of services of type k around the city center. 

▪ GC = generalized travel cost: average distance from city center to service k. Expressed in km. 

▪ α = weight to be calibrated. 

▪ β = weight to be calibrated. 

▪ ωk = weight based on the relevance of the service of type k among the other types. 

5.5.1 The Alpha Parameter, 

The alpha (𝛼) parameter represents the exponent to which the number of each type of service is 

raised. Understanding the logic behind this value requires considering the perceived utility of 

services surrounding the city from a user's perspective. As the addition of more services occurs, 

the overall utility begins to saturate, exhibiting a trend that is less than proportional. 

API Key 

 

API Key 

11. Organize spreadsheet as given for 

the easy calculations. 
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For this purpose, the study utilized trade data (conducted a trend analysis) acquired from the 

Account Division of the primary case study city Kurunegala. The Municipal Council provided annual 

data for the year 2023. We then determined the importance of each category by summing them up. 

This approach enhanced the clarity of the index. This was conducted in a hypothetical situation 

where trade tendencies depend on people's needs. 

Deriving Alpha values based on trade data Sum of the 3374. Weighed Arithmetic means applied to 

this in deriving alpha(α) values.  

• Weights were given considering percentages. Alpha values are assigned using that. 

 

Figure 15:Utility Curve 

 

Table 2 : Derived alpha values after giving weights to identified prioritized fields accordingly.  
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5.5.2 The Beta Parameter 

The beta (β) parameter indicates the decrease rate of the impedance function as the distance from the 

city increases. A smaller β value leads to a lesser damping effect on each service's score contribution, 

whereas a larger β value results in greater attenuation. Generally, literature assigns a value of 1 to this 

parameter (Paez, Scott, Morency,2012). 

5.5.3 The Omega Parameter 

Further, the weights (each single 𝜔k) serve as parameters that favor the scores of certain types of 

services over others. The selection of each weight depended on the relevance of each service within 

the city's context. To achieve this, the study conducted a survey. Omega parameter weight extraction 

depends on the preference of people on weekdays.  A random sample was taken of forty people from 

the city at peak hour. Based on the majority of service preferences Omega values were assigned,  

 

 

 

 

 

 

 

 

 

 

 

 

Table 3:Derived Omega values after identifying prioritized field results from the survey conducted. 

 

 

Figure 16: Survey results 
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5.5.4 Calculations of the City Attractiveness (services) Index: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

12. Partial score of every 

service of the city must be 

calculated and sum of that 

would be the city index.  

.  

Formulea used 

 

Formulea used 
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• Sample calculation indicated using a black box (Partial score of Administrative services in city 

Kurunegala.) 

 

𝛼 will be the same across the selected 4 cities as all of them are considered Medium-sized cities 

partial score = ωk * n𝛼 (Σ exp(-β*GC)) 

 

SCORE city = Σ (partial score k) 

 

Table 6:Calculations of the city attractiveness Index. 

 

 

Table 7:Comparison of the Index values. 

 

 

 

 

Table 5:Comparison 

of the Index values. 
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The gravity index was calculated for all cities, ranking Kurunegala, Kegalle, Kalutara, and Dambulla in 

order based on their service attractiveness from the city center. This score indicates a city's 

attractiveness based on the services developed within and surrounding it. The model shows Dambulla 

city's facilities are lacking, resulting in a low attractiveness index, while Kegalle and Kalutara maintain 

the same level of attractiveness. In contrast, Kurunegala is identified as the most attractive city, 

attributed to its superior service provision considering the city center as the nuclei. Deployed the same 

omega value of Zero indicated that the results would be more or less similar except for the cities 

Kalutara and Kegalle. Therefore, the preference of people is a fact. 

6. ANNEXURE 

Field data was collected through Google Forms, employing both observational and questionnaire 

surveys (on the field). The main goal of this research was to refine the validation methods used to 

calculate omega values. It also investigated the patterns of movement of people within the primary area 

of study and considered their service preferences and choices as part of the analysis. 
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6.1 Questionnaire to derive omega values. 
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6.2 Summary of the Responses 
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6.3 Preparation of maps 

1. Use Suitable Colors & Symbols 

2. Show adjacent administration boundaries.  

3. Maximum utilization of map space 

4. Show the Graticule Network with the appropriate grid size. 

5. Show the basic elements in the map.  

a. Transportation Networks   

b. Water Bodies 

6. Prepare a descriptive map.  

a. Label notable features. 

i.  Major Road Types 

ii.  Major Rivers  

iii. GN Boundaries 

iv.  If needed, show the location of the area in a different data frame. 

7. Check the units of the scale bar. 

8. Mention the correct units at the legend. 

9. Check the text given in the legend. 

10. Mention the correct sources. 
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Examples    

 

Examples    

Maximum utilization of map space 

 

 

Maximum utilization of map space 

 

Check the units of the scale bar. 

 

 

Check the units of the scale 

bar. 

 

Mention the correct sources. 

 

 

Mention the correct sources. 

 

Check the text given in the legend. 

 

 

Figure 17:Incorrect formats of mapsCheck the text 

given in the legend. 
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AFTERWORD 

Medium-sized cities play a pivotal role in achieving national sustainability targets, yet often lack the 

analytical tools to evaluate urban service accessibility. Rooted in Urban Informatics, this guide presents 

a systematic, spatially-explicit approach to assessing progress toward the 15-Minute City concept, 

integrating Google API data, GIS, and accessibility metrics. 

 

By highlighting service equity and spatial justice, this book contributes to a deeper understanding of 

urban function and livability in secondary cities. It is our hope that this work supports both local planning 

efforts and broader urban policy frameworks, making cities more inclusive, walkable, and resilient.
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